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Conventions
The typographic conventions used in this help are described below.
Convention Description
Bold Used to denote components of the user interface such as

buttons, field names, menus, and menu options.
For example, the New button.

Menu...MenuOption Select the menu from the menu bar then select the menu option
from the menu.

For example, File...Open would mean to select the File menu
and then the Open option.

CAPS Used to denote the name of a key on the keyboard.
For example, the ENTER key.

Italics Used to denote emphasis, captions and the result of an action in
a procedure.

Contact Us
General enquiries on the HoloLive! for DigitalMicropraph should be sent to:

HREM Research Inc.

14-48 Matsukazedai

Higashimatsuyama

Saitama 355-0055

Japan

email: support@hremresearch.com
Website: www. hremresearch.com

Enquiries on HoloLive! of a technical nature should be directed to:

Dr. Christophe Gatel
CEMES-CNRS, Toulouse, France
email: christophe.gatel@cemes.fr
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Introduction to HoloLive!

Welcome to the HoloLive! plug-in for DigitalMicrograph (Gatan Inc.). This software is
designed to provide live phase images during off-axis electron holography experiments, hence
the exclamation mark. The software was developed because electron holograms are almost
impossible to interpret directly by the human eye: the important information is contained in the
phase, which requires reconstruction. We have found that being able to see the phase during
holography experiments changes the experience completely, particularly for in-situ work.

The main requirement is that the live holograms at the microscope are displayed within
DigitalMicrograph, in the usual viewing mode for Gatan cameras. As the hologram changes
over time, HoloLive! automatically recalculates and displays the corresponding phase image.
Using current computing power, a speed of 4 phase images per second can be obtained for a
full 4K by 4K digital hologram, with even higher speeds for smaller-sized holograms. Live
features include:

e Automatic detection and tracking of side band (via live FFT)
Carrier frequency refinement (via user-defined reference area)
Distortion correction (via a reference hologram)
Phase unwrapping
Fresnel fringe filtering
Amplitude and Cosine visualisation

HoloLive! has been briefly described in the following publication:

[1] C. Gatel, J. Dupuy, F. Houdellier, M.J. Hyjtch, Appl. Phys. Lett. 113, 133102 (2018).
Unlimited acquisition time in electron holography by automated feedback control of
transmission electron microscope. 10.1063/1.5050906

Development versions of HoloLive! were used extensively in the following in-situ electron
holography work:

[2] C. Gatel, B. Warot-Fonrose, N. Biziére, L. A. Rodriguez, D. Reyes, R. Cours, M.
Castiella, M.-J. Casanove, Nature Communications 8, 15703 (2017). Inhomogeneous

spatial distribution of the magnetic transition in an iron-rhodium thin film.
10.1038/ncomms15703

[3] C. Gatel, X. Fu, V. Serin, M. Eddrief, V. Etgens, B. Warot-Fonrose, Nano Letters 17,
2460—2466 (2017). In Depth Spatially Inhomogeneous Phase Transition in Epitaxial
MnAs Film on GaAs(001). 10.1021/acs.nanolett. 7b00144

Without phase visualisation during experiments, how can you tell if the data being collected is
valuable? And during in-situ work, how could you tell if the applied stimuli are indeed changing
the fields? HoloLive! has been designed to help you during experiments, to make them more
productive and more interactive.

In this manual, we will dive straight into the use of the HoloLive! package with a prepared
example. Indeed, we have provided a stack of holograms, acquired experimentally, to simulate
work at the microscope. A simple script refreshes the hologram in a viewing window by cycling
through the data stack.
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But before starting, there are a few important points to remember:

1. HoloLive! is a plug-in for DigitalMicrograph (Gatan Inc.). This means that results are
fully compatible with the other functions present in DM. For example, profiles drawn
across the live phase images using the DM line profile tool will be automatically
updated. Similarly, any calibration of the images within DM will be transferred to the
phase images.

2. The complete list of commands related to HoloLive! are located in the menu:

HoloLive! Control Window... Settings
Play
Pause Luean
Stop Settings...
Reference Area > Apply...
Live FFT Modulus Set Factor
LI Set Increment
Phase Unwrapping Update
Cosine
G Live Contrast
Shared Tools > I Change Project Name
Restore Factory Settings Define Image Type
Create ROI for Extract Area
Help
Extract Area
About...
Calcul of Lambda and CE
HoloLive Simulator ...

3. However, it is more fun to access command using the HoloLive! control window. The
following window can be opened from the first menu of the HoloLive!:

HoloLive
Display
Binning Mer C

WA C

NE# Mask Size Type Fresnel

I Apply [l Keep sameq

wait [XJlls | 0.000s

Il Freeze qvector [l Unwrap
{ > J o I 5 .
A [d A @ aw

In the following, we will assume use of the HoloLive control window, but all commands
can be accessed via HoloLive menu.

Like a TV remote controller, check out the overall features on the next page.
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HoloLive! Control Window

HoloLive Reference
5 Area
I.:J|s.play ) Stop ——
Binning  MgP O Play/Pause — FFT
m HA C
Zoom

&l Mask Size Type Fresnel

I 2Apply M Keepsameq

wait [ s | o000 s

Turbo
reeze g vector i Contrast T

Il Freeze q vector [l Unwrap Boost
LDJ Lna D LJ Unwrap Refresh

E E BT Phase Display

Cosine

Note : CTRL and clicking on a button will reveal the Settings (if present)
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HoloLive! Tutorial
Getting Started

Open the image “Live Hologram” using the DM command File...Open from the HoloLive
Manual folder:

1 e v ram - 0 x

Technical note: this hologram was
acquired on the I2TEM microscope in
Toulouse (Hitachi HF 3300-C) using
a 4K OneView camera (Gatan Inc.)

It does not look like much for the moment but it is a real hologram. Use the DM magnifying

glass tool % to zoom in to see the narrow hologram fringes. Hint: if you are new to GMS 3,
remember you need to right-click on the image for the tools to appear.

Now let’s use HoloLive! to calculate the phase image from this static hologram. Later on, we
will make this image move to simulate a microscope session. Select the “Live Hologram”
image by clicking on it somewhere (as usual in DM) and then just click on the Play button in
the HoloLive! control window:

HoloLive

Display

Binning P

mA o s

Hint: if someone else has been

Gl Mask Size Type Fresnel playing the HoloLive! before you,
check that the options in the control
‘. ‘ . window look like this and change

Apph K :

S | heapsmEt values if necessary. You can also use

wait N s | 0000 s HoloLive...Restore Factory
Settings.

B Freeze qvector [l Unwrap
(> J I |
A (d B ©mw

Since this is the first time HoloLive...Play operates on this particular image window, the
power spectrum of the hologram will be displayed along with the all-important dialog
window. It should look something like this:
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I £ Power Spectrum of tolograr -0 x

Phase Calculation X

= RNELEI | ive Hologram

Mask

Swap 2235

Display
Binning Phase O

o me

Reference NEHQT 1]

M Apply Correctio.. |l

Cancel

Technical note: the power spectrum is the modulus squared of the Fourier transform of
the image. To avoid streaking from edge effects, the image was prefiltered. Any remaining
vertical streaking is due to the camera (in this case) or the finite width of the hologram.

Notice that the side band (at carrier frequency q) has been automatically detected and a red
circle has been placed around it with a radius indicative of the mask size. If for some
inexplicable reason (this is a worked example!) there is no circle or the circle is in the wrong
place, press Cancel. The Phase Calculation Window will disappear allowing you place a DM
rectangular ROI tool [}~ around the side band. Press again on Play and HoloLive! will
use the indicated position. Just make sure the ROI encloses the side band spot...

We will look at the other features later, but for now just click on OK, and you should see you
first phase image, called “Live Hologram P”*:

Technical note: we like displaying phase
images using the “Temperature” colour scale
in DM but you can use grey scales if you
really want, just use the DM menu
Object...Image Display...Color. The actual
values in the phase image will not be
changed, only its appearance.

Technical note: in HoloLive!, every
image has a “type”, used in the titles and
in the image tags. For example, a phase
image is type P.

AT
) :

You may have noticed that the Play button has moved to Pause:

RN
LA

-8-
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HoloLive HoloLive
Display Display
Binning Mer O Binning Mer O
A O Hint: if ever your close the phase i =~ O
8@ Mask Size Type Fresnel 1mage, by mistake or by deSIgn’ you 88 Mask Size Type Fresnel
i may notice that the P box becomes i
(2] unticked. HoloLive will continue (2]
M Appy [l Keep same q working in the background. To make M Apply [l Keep same q
wat (ENs | 0000 s the phase image reappear, just click the wat (NS | 0000 s
P box.

Pl Freeze qvector [l Unwrap
ODolL=
0408 @

[l Freeze qvector [l Unwrap
ODolLM =
048 @

This is normal, indicating that HoloLive! is running. The phase image is not changing though
because the hologram is static. We will see moving phase images and the use of this
Play/Pause button later.
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HoloLive...Reference Area

It is customary when analysing phase images to define a reference area. Usually, a region of
vacuum is chosen where the hologram is undisturbed by any stray fields. In this example, the
whole hologram was taken in empty vacuum so you can choose anywhere using the DM
rectangular ROI tool. Alternatively, you can use the default setting of HoloLive! and just
click on the Reference Area button:

loLi )
e ;.Ls::y Technical note: the default for HoloLive!

Bning  MgP O is a reference area at the centre of the
A O image, rotated parallel to the hologram
fringes. This can be modified in the
HoloLive...Reference Area...Settings.
O These settings can be accessed via the Reference Area X
HoloLive! menu or by pressing CTRL while
clicking on the Reference Area button.

NE# Mask Size Type Fresnel

Il Apply [ Keepsameq

Automatic Upda...

Automatic Rotati...

wait (Xl s | 0.000s

W Freeze qvector [l Unwrap
(11 J = RS Iy ]
R (d B @ ar

Remove Mean Val..

Display Mean and Std. D...

HoloLive! will determine the average phase gradient in the reference area and subtract the
corresponding phase ramp from the whole image. This is equivalent to ensuring that the
carrier frequency q corresponds exactly to that of the chosen reference area of the hologram.
The result should look like this:

g

Hint: if nothing happened, use
the Refresh button to make sure
HoloLive! updates the phase
image (this is a static hologram
after all).

HoloLive

Display
Binning P O

WA O

Mask Size Type Fresnel

Wa\tms | 0.000 s

[l Freeze qvector [l Unwrap
DOo0C &
@@ E @

The mean phase and standard deviation of the phase in the reference area are displayed on the
top left of the reference ROI. Feel free to move the ROI around and you will see the phase
image automatically updated (if not, check that the Automatic Update box is ticked in the
HoloLive...Reference Area...Settings. Remember that CTRL plus clicking on the
Reference Area button will display the settings.) You can also change the size, shape and
orientation of the ROI by grapping and dragging the different corners. Have a play.

-10 -
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Live Holograms

We could continue explaining the other features using a static hologram but it is more fun to
use a live one, just like at the microscope.

To simulate an on-line holography session off-line so to speak, we have created for you a
stack of 50 holograms acquired on the I2TEM microscope in Toulouse. Open the image stack
“HoloLive stack™. It is a stack of 4K by 4K holograms weighing a total of 3Gb so there might
be a pause. Scroll through the holograms if you like with the Slice tab of the DM Display
window (if absent use DM Window...Floating Window...Display). Now launch the menu
command HoloLive...HoloLive Simulator. Check that the “Live Hologram” image is still
open (and preferably the frontmost image). You should see the following dialog:

HoloLive! Control Window...

Play

Pause

Stop View D: Live Hologram 65536k v
T > Stacked B: HoloLive stack 3276800k ~
Live FFT Modulus

Zoom

Phase Unwrapping >

Cosine >

Hint: to stop the
Power Spectrum Simulator press on
Shared Tools > CRTL-SHIFT
Restore Factory Settings

Help
About...

HoloLive Simulator ...

Choose as shown the “Live Hologram” to be the equivalent of the viewing screen (View) and
“HoloLive stack” to provide the images. On OK the script will replace the hologram in the
Live Hologram window with a hologram from the stack. The frequency is determined by the
number variable “wait” in the script (in seconds). Change it if you like. To halt the movie,
press down CTRL-SHIFT.

As if by magic, you should see the phase image changing as if it were live. The delay between
phase images is displayed on the HoloLive! control window:

HoloLive HoloLive

Display Display

Binning NP olnring e O
WA : WA O
Hint: make sure you are =2
Mask Size Type Fresnel on Binning 4 (OI' hlgher) [ Mask Size Type Fresnel
(2] unless you want your o)
computer to have a

M Apply  IllKeep sameq headache. See later for HAppy BKeepsameq

wait [XJlls | o0600s more details. wait [XJlls | o0600s

[l Freeze qvector [l Unwrap
OOl =
A (d A @ awr

[l Freeze qvector [l Unwrap
ool =
B d A @ anr

-11 -
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On the laptop used for writing this tutorial, the time is about 0.6s and varies depending what
else is going on the computer. To speed things up use the Turbo Boost:

HoloLive
Display q
Bning  MgP O Technical note: In fact, MT stands for
HA O “Multi-Threading”. By programming in
parallel certain operations in the sequence
(FFT, masks, reference) the delay
(4] between successive phase images is
reduced. However, the time to create the
first phase image in a sequence is always
wat (s | 0305 s the same and corresponds to the delay
time without Turbo Boost.

BNE# Mask Size Type Fresnel

Il Apply [ Keep same q

M Freeze qvector [l Unwrap
oo™
B [d A @ e

Use the Play/Pause button to stop and start. Note that there is a delay between stopping and
starting. This is because it takes a certain time to create the first phase image in a sequence
which is longer than the delay between successive phase images using the Turbo Boost.

Please be kind to HoloLive!
Your computer is having to do some pretty heavy calculations, especially
with a stack of 4K holograms. Everything has been done to optimise the
algorithms in order to reach these speeds but the computer is working flat
out. There will always be slight delays after clicking on a buttons. Please be
patient before clicking again.

To assuage your computer, you can always include a “Wait” time:

HoloLive
Display

Binning Mr O

HA O Hint: after putting say 1 into the
Wait box, click somewhere else for
it to be taken into account. You
B should see the 1 become 1.0 as
oe [ Jziesme HoloLive! recognises a number

wait [NJlls | 0305s

Mask Size Type Fresnel

M Freeze qvector [l Unwrap
0oLl =
@ 4B e

You may hear your laptop less overheating. There are, however, better ways to help your
computer by using Binning and ROIs, as we will see later.

-12 -
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HoloLive... Live FFT Modulus

By default, the FFT of the hologram is shown live alongside the phase image. If it is not, click
on the FFT button in the HoloLive Control Window:

HoloLive

Technical note: it is too time consuming for

Bpis.p'ay ) HoloLive! to calculate a live Power Spectrum (which
inning P O . . .
o = O includes masking in real-space). The FFT button
- shows the modulus of the FFT of the hologram
53 Mask Size Type Fresnel (which had to be calculated anyway for the phase

image). You will therefore notice streaking of the
= spots. Purists can see the static Power Spectrum
W Appy WlKeepsameq using HoloLive...Power Spectrum.

wait [KJlls | 0305s

Il Freeze qvector [l Unwrap
{14 J T R T 0]
2@ E e L

Now place the Live FFT next to the phase image:

d A © aw

If you press on the FFT button again, this closes the Live FFT window. Not to worry, you can
press on FFT button to make it reappear.

The FFT button does more than just displaying the FFT. It can be used to control the choice
of sideband. Place a DM rectangular ROI around the other sideband like so:

- 13-
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0.0000)
0.2409)

NN W
Now press down SHIFT and click on the FFT button. This tells HoloLive! to hunt for the

sideband within the ROI. You should see the red circle denoting the mask swap to the new
position:

X: Live Hologram MFFT o x

9 - Live Hologram P

Notice that the phase has changed sign, as it should do since q has changed to —q. This is such
a useful operation, that we have included a special Swap button on Mask Size tab of the
HoloLive Control Window to do this:

HoloLi - . . .
o; 'vle Technical note: the choice of sideband is
e : important for subsequent quantification. Our
Binning P O . . . s
- = convention is that the sideband pointing towards
: the reference wave (usually the vacuum) should
Ref IR Type Fresnel be chosen. In that case, the phase is positively

: proportional to the mean-inner potential of the
material. A positive phase gradient means

2235 | increasing sample thickness.

wait (Il s | 0542

[l Freeze qvector [l Unwrap
Dol s
B4R Ear

- 14 -
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Have a go but remember the delay.

The main reason for including the ROI option on the FFT was for cases where HoloLive!
does not find the sideband. A classic example is when a hologram becomes too noisy (for
example, after jolting the microscope or biprism) and loses all contrast. The ROI guides
HoloLive! to the right place. Another way to avoid such mishaps is to use Freeze q vector:

HoloLive

Display
Binning P

o m

Ref WVEH@NF Type Fresnel

ez - Jooio |
ED

wait [XHlls | 0542 s

(] M Freeze qvector Wl Unwrap

o=

B [d B @ aw

By choosing this option, HoloLive! no longer hunts for the sideband in the live FFT, it just
continues to use the same carrier frequency q. There is a slight increase in speed. Unticking
the option just lets HoloLive! go back to automatically detecting the sideband.

A typical experimental procedure is to change the biprism voltage and the carrier frequency
changes. Untick the Freeze q vector and HoloLive! tracks the carrier frequency. Once the
biprism voltage is stable again, Freeze q vector can be reselected.

Another use of freezing q is to detect electric fields during in-situ biasing experiments. The q
vector can be frozen in the vacuum area, when a bias is applied, any gradient in the phase
image indicates the presence of an electric field. With automatic tracking, the phase gradient
would be automatically removed!

HoloLive...Mask Size

Since we are on the Mask Size tab, let us look at the effect of changing the mask size for the
phase reconstruction.

HoloLive

Display Technical note: the default mask radii are the
Binning P O following: Small q/4, Medium q/3 and Large

o m: O q/2.

Type Fresnel

Technically, a mask size larger than Medium
lets information from the centre band leak into
the masked region. Holographers argue about
whether Large is acceptable or not.

el

wait (Xl s | 0542

M Freeze qvector [l Unwrap
Dol ®
APRERCL

-15-
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Use the scroll-down menu to choose a “Large” mask size. You should see the following
result:

I x: tive Hologram P o x

Technical note: these
figures give the spatial
resolution of the phase
reconstruction. The
upper figure is in
pixels and the lower in
nm. If the original
hologram has not been

ooooo

The red circle has a larger radius on the live FFT and the phase image should look noisier but
finer grained. The standard deviation of the phase is indeed larger (see the information on the
Reference Area ROI). The spatial resolution of the phase map is now higher (see the
information on the HoloLive Control Window.) This is the price to pay for higher spatial
resolution: a lower signal-to-noise ratio for the phase.

You can choose any mask size by scrolling down to Custom and filling in the spatial
resolution you want into the boxes (either in pixels or in nm). Choose 5 nm spatial resolution
for the phase reconstruction:

8 P Live Hologram P

Technical note: in
fact, you do not even
1) =-—=- need to scroll, just fill

wat (CNs | 0725 5

—_— in one o.f the two

coOoO® boxes directly.

(%) |] EE ®© =

This is indeed a better way to define the mask size as it does not depend on the carrier
frequency, which might change during the experiment.

Now that we have seen the FFT, let us be nice to the computer and close the FFT window.

Just close is as usual in DM or click on the FFT button. If you need it again, just click on the
HoloLive FFT button.

- 16 -
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The large phase variations seen in this example are due to optical distortions of the
microscope, the projector lens distortions to be exact. To remove them, the conventional
procedure is to acquire a reference hologram in empty vacuum. Put HoloLive! on Pause and
open the reference hologram that we have supplied “HoloLive Reference”:

E: HoloLive Reference

E HoloLive Reference.

Technical note: this
reference hologram has some
pretty sensational contrast
because we used the drift
compensation, exposure time
of 4 mins and n-shift
reconstruction (see Gatel et
al. APL 2018)

Hint: use the DM magnifying glass

tool Q to zoom in.

With the “HoloLive Reference” as the frontmost image, click on the

HoloLive...Reference...Load button:

HoloLive HoloLive
Display Display
Binning P O Binning P O

WA O mA O

NE# Mask Size Type Fresnel Sl Mask Size Type Fresnel

By " HoloLive Reference

Il Apply [ Keep same q Il Apply M Keepsameq

wait [(FJls | 0305s wait (Xl s | 0364 s

M Freeze q vector [l Unwrap W Freeze qvector [l Unwrap
ool = oo L] &
B [d A @ =w B [d A @ =

Technical note: as usual there
will be a pause as HoloLive!
calculates and stores the phase
reconstructed from the Reference
Hologram.

When it is over, the title of the
image will appear. It will be
truncated to fit into the box.

HoloLive! uses exactly the same parameters (notably the mask size and binning) to
reconstruct the phase of the reference hologram. It stores the result ready for use.

Set the live phase image off again by clicking on the Play button and click on the Apply box

to see the correction work:

-17 -
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HoloLive
Display
Binning )

HA O

Mask Size Type Fresnel

p T HoloLive Reference

Apply [l Keepsameq

wait [FJls | 0207 s

[l Freeze qvector [l Unwrap
oDooH=
@ @B Ean

The phase variation across the field of view is much smaller. Click and unclick Apply to see
the improvement. Ideally, there should be no phase variation on correction (apart from the
noise from the counting statistics). As is often the case, the reference image was acquired a bit
later in the day when the imaging conditions had changed slightly.

Reference hologram...Keep same q

The reference phase was reconstructed using the same parameters as the live phase image, but
not necessary the same carrier frequency q. Indeed, HoloLive! hunts for the sideband
automatically and determines the peak position itself. This can be useful because the biprism
voltage can change slightly, or wilfully, between the current conditions and the reference
hologram conditions. Purists, who want exactly the same carrier frequency to be used for the
current hologram and reference hologram, can use the Keep same q option:

HoloLive
Display
Binning P

o m

PO Mask Size Type Fresnel

g T: HoloLive Reference

Apply Keep same q

wait [EJlls | 0394 s

[l Freeze q vector [l Unwrap
D00 =
A [d A @ =

HoloLive...Unwrap Phase

As is well known, the phase is well defined in a range of 2rt, and in our convention between -
7 and . Holographers sometimes like to “unwrap” the phase. This means extending the phase
continuously beyond the 2r range. For example, if we are looking at a wedge-shaped sample,
we would like to see the phase from the mean-inner potential increase continuously from the
edge of the sample. We have therefore included an unwrapping capability.

To see the full effect, remove the Reference Hologram correction (untick Apply) so that the
phase has many phase jumps. Now click on Unwrap Phase to see the transformation:

- 18 -
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Hint: Noisy images
can cause phase
unwrapping to fail or
give weird results.
Reduce the mask size
to compensate.

With the Turbo there is little loss of speed thanks to many hours of optimising the code...

There is no unique solution to phase unwrapping in two dimensions and several methods have
been developed with their advantages and disadvantages'. The slower ones tend to be more
robust but for live phase visualisation speed is important. We have therefore developed two
algorithms (based on the Goldstein approach): one very fast and another one which is more
conventional. You can choose which one in the HoloLive...Phase Unwrapping...Settings:

Phase Unwrapping Setup X

Algorithm
O Quick

@ Conventional

Cancel

The tutorial holograms have a good signal-to-noise ratio, so the only difference you will see is
probably in the speed of execution. However, for noisier images the Conventional setting will
produce better results.

! See the excellent book by D.C. Ghiglia & M.D. Pritt, “Two-dimensional phase unwrapping: Theory, algorithms
and software” (John Wiley & Sons, Inc., New York, 1998).

-19 -
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HoloLive...Zoom
Sometimes, you do not want to see the phase image corresponding to the whole field of view.
HoloLive allows you to see the phase in a smaller region.

First, put HoloLive on Pause (this is not absolutely necessary but is politer to the computer)
and select the Live Hologram window by clicking on it. Then draw a region with the DM
rectangular ROI tool:

18 & L Hologram .o x

Hint: if you hold down SHIFT,
you force a square region, and
ALT-SHIFT forces sizes of
powers of 2. Do not worry
though, HoloLive can deal with
any size or proportion.

Now click on the HoloLive...Zoom or Magnifying Glass button:

HoloLive
Display
Binning p

m:

Mask Size Type Fresnel

Il Apply [ Keep sameq

wait (KRl s | 0000 s

[l Freeze qvector [l Unwrap
[> J = R R i |
B (d 3 @ awr

HoloLive will calculate and display the phase image corresponding to only this small region
of the hologram:

-20 -
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Technical note: the phase
image is calculated using your
current settings except
Reference Area.

Notice that the ROI has become yellow, which indicates that it is active in HoloLive.

You can even move the ROI around (use the DM select/arrow tool to click inside the ROI,
then holding the left-click down, move the mouse) and the phase image is updated
automatically. You can maybe see this more clearly by not applying a reference hologram
correction and freezing the q vector.

The size and shape of the ROI can also be changed. However, be careful not to grab one of
the corners and change the shape too rapidly! HoloLive has to recalculate from scratch each
time the size changes and performance suffers. Be kind to the computer, shape changing is
best done gently (even maybe on Pause).

221 -
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HoloLive...Cosine
While we are in the Zoom mode, let us look at the Cosine button and click:

HololLive

Display Technical note:
Binning PO the amplification Factor
m HA O determines the cosine phase
magnification. Displayed will be
the cosine of the phase times the

NE# Mask Size Type Fresnel

Il Apply [l Keep same q % DigitalMicrograph X

o .
e m s | 0000s Amplification factor ?
| 2.0

M Freeze qvector [l Unwrap i -
u D D |Z| " OK Cancel
5 ol . g} 5 \ ) e
A48 @ e

With an amplification factor, o, HoloLive! will display cos(a¢) in a new window, where ¢ is
the phase... For the default factor of two, the result will look something like:

Hint: to change the cosine
factor en route, CTRL click
on the Cosine button to
modify the setting.

Holographers sometimes finds this useful to accentuate the phase variations. In fact, the
cosine function harks back to the original way of phase visualisation in the analogue days pre-
digital.
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HoloLive...Contrast

Another useful feature linked to a selected area in the hologram image is the Live Contrast
function. Make sure that the Live Hologram is the frontmost image, and click on the Live
Contrast button:

HoloLive
Display
Binning P C

B m-C Technical note: you do
not even have to have
phase images running
for this function to

B Apply [ Keepsameq work.

wait (Xl s | 0000s

[l Freeze qvector [l Unwrap
ool ®
B 43 @ amn

Mask Size Type Fresnel

If an ROI was present, HoloLive! will use it, otherwise a default ROI will be created:

Hint: feel free to move
the ROI around or to
change its shape or size.

The information provided from top to bottom is the following: hologram fringe contrast,
fringe spacing in pixels, and the corresponding spacing in nm if the image has been calibrated.

The contrast uses the same definition as fringe visibility:
_ Imax = Imin

Imax + Imin .

In the presence of noise, we should isolate the fringes from the background and measure their

average amplitude. However, for speed, we use an approximation based on the ratio of the

standard deviation of the intensity to the mean intensity:
1 o)

=7
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For pure cosine fringes, the result would be correct. However, the method breaks down for a
noisy image with weak fringes. In the extreme case, in the absence of hologram fringes, we
would be measuring the noise level rather than the fringe contrast. Bare this in mind.

HoloLive...Stop

All this time you may have been wondering what the Stop button does and the difference with
Pause. Give it a go:

HoloLive
v Display
Binning P O You may not have seen everything but it
B m: O is enough for now.
ot | e e G This is the end of .the tutorial for
HoloLive!

M Apply M Keepsameq

wait [XJlls | 0000 s
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